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Getting
started
Introduction
The software has a built-in introduction which will take you through the initial steps, and overall workflow. You can view that
introduction at any time by choosing “Introduction” from the help menu.

Registration
Running the software in trial mode will prompt you to enter a license key each time you start the application. The message will no
longer appear once you have purchased the software.

See also the License & Registration FAQ.

Preferences
By default, the application is using “safe” settings for audio and display. This includes quite a high audio latency, which you might
want to lower.

Visit the Preferences to customize your audio and display settings.

https://www.sononym.net/registration-faq/


User
Interface
The user-interface is divided into the following sections:

1. Activity
Bar - select sidepanel and view warning/activity badges
2. Sidepanel - contains Libraries, File Explorer, Projects and Favorites
3. Main
Toolbar - query history + playback/volume controls [link]
4. Waveform
Display - displays similarity source / selected waveform [link]
5. Aspects
Dial* - for adjusting an active similarity-search [link]
6. Search
input - current path, search terms and keywords [link]
7. Filter
Banner - displays/applies search filters [link]
8. Search
Results - table containing search results [link]
9. Similarity
Ratings* - columns with similarity-search ratings [link]

10. Filter
Panel - manages search filters [link]
11. Status
Bar - display status, progress indicators, and so on…

*
Only
visible
while
in
similarity-search
mode

Display
Configuration
You can customize the color theme, font size and other display options from Preferences

In addition, you can change following from the application menu

Change the overall Zoom factor
Enter/exit full-screen mode
Toggle various user-interface elements

A special option, which is available on Windows only, is the ability to hide the menu bar. When you choose to do so, the ALT button is used for
toggling the menu bar on and off.

Drag-and-drop
The application supports bi-directional drag-and-drop. Meaning, that you can drag files and folders on top of the application and
(audio) files out of the application window.

It’s possible to drop audio files onto the application to launch a similarity search, or folders. The latter will convert the folder into a
library, or, if already indexed, open the library.

Additionally, you can drag files around within the application itself. This will allow you to move folders or files with ease, in
a
way
that
ensures
that
your
Sononym
projects
and
favorites
are
kept
up
to
date.



Detachable
panels
It is possible to “dock” panels in a secondary side-bar (on the right-hand side), as well as more flexible grouping on the left side. All in
all, this allows better use of the horizontal space.

To detach/reorganize panels, simply click the desired panel header and drag it to your desired destination.

The destination can be the Activity Bar (1), Sidepanel (2), or the Secondary Sidepanel (not shown).

The Secondary Sidepanel is initially hidden, but will reveal itself once you drag a panel near the edge of the window.
Also, you can reveal the Secondary Sidepanel from the View menu, or by carefully dragging from within the right edge of the window.



Locations:
Libraries
Libraries are folders on your harddrive that have been analyzed by the software. Technically, they are small databases containing
information about your samples. These data provide the foundation for similarity-search and many other features.

The libraries tab

1. Libraries - list of libraries that are currently available
2. Folder
tree - displays folders for the selected library
3. Search
Results - a table displaying your search results

Library
Options
To view options for a given library, right-click and select it.

Refresh
(Look
For
Changes)
Choose this to look for new/changed/deleted files. Existing information in the database is retained.
This option is also available in the context menu, and will perform the same action but
for
a
specific
subfolder
only. For large libraries,
this is much faster than performing a full rescan.

Rebuild
(Hard
Refresh)
This will perform a complete rebuild of the library. Any modifications that you have performed (e.g. changed categories) will be lost.
For the same reason, this action is preceded with a warning message.

Use
Local
Drive
For
Collected
Data
Enable this option to let Sononym host the database in the application config folder. When disabled, the application will store the
information in the root folder of the sample library.

This option is practical when your samples are stored on read-only media, or if you dislike having database files (‘sononym.db’) scattered across
your harddrive. Also, it might be that your media doesn’t support exclusive locking, which is a requirement for writing to the database.

Treat
Location
As
Read-Only
When enabled, the application will not be able to perform modifications to the location. This option is automatically enabled when
read-only media was detected during initialization.

Selecting
libraries
The list of active libraries appear in the topmost part of the Location sidepanel, while the “Libraries” tab is active. And your search
results are of course dictated by what library(-ies) you might have selected in this list.

To select a library, simply click it. To select more than a single library (i.e. combine libraries on-the-fly), hold Command/Ctrl pressed
while selecting a library, or use the Shift modifier to “extend” the existing selection. You might notice a brief preparation time, after



which the “combined” results should appear in the browser.

Current
Limitations: there is currently a limit to how many libraries that can be combined on-the-fly. If you have chosen more libraries than the
software supports, any libraries shown with a “striped” background will not included in the results.
Note that this striped background is also applied to libraries whose content isn’t available for some other reason (e.g. in need of an upgrade, not
found on disk etc).

In the list of libraries, any library can be right-clicked to bring up it’s context menu. A special case is when multiple libraries are
selected: in such a case, right-clicking within the selection will bring up a context menu that applies to all the selected libraries instead
of a single one.

If you have selected multiple libraries and need to show options for a specific library within that selection, this is possible too: press the “gear”
icon on the left-hand side to bring up its context-menu.

The panel also allows you to drag items around in order to re-arrange them:

Dragging items to re-arrange

In addition to re-arranging by dragging, you can also sort libraries by name or path via the context menu.

Creating
&
Opening
If you’ve used Sononym for more than a few minutes, you will probably already have created a library.

Creating a new library is meant to be as easy as possible - you can simply drag a folder on top of the application. Alternatively, you
can pick a folder using the “Add library” button, or by choosing “Create Library” from the File menu.

If the selected folder is already a library, it will immediately be added to the list of libraries. Otherwise, the application will start to index
the contents and shortly, samples will begin to appear. You can track the indexing progress in the upper part of the sidepanel, as well
as in the status bar.

Refreshing
(Look
for
Changes)
Of course, your sample collections aren’t necessarily static. You might add, change or move files around at any given time. When this
is the case, the Sononym library will need to be refreshed in order to pick up those changes - this will ensure that the file database is
up to date.

To refresh, head into the list of libraries and right-click the library you want to refresh. Next, choose the menu entry called Refresh.

Note that refreshing a library doesn’t require all files to be re-analyzed - only new arrivals and changed files are processed.

Upgrading
a
library
If a library was created with an older version of Sononym than the one you’re using, the library might need to be ‘upgraded’.



When multiple libraries are in need of upgrade, you can choose to batch upgrade them:

The dialog will allow you to run the upgrade process simultaneously on all libraries, or one library at a time. Upgrading one library at a
time might require less computer resources.

Removing
libraries
To remove a library, choose “Remove” from it’s context-menu (the library itself is located in the list of libraries). The following prompt
will appear:

Remove - choose this option to remove the library from the list of currently active libraries in Sononym, but leave the collected
data untouched.
Delete - choose this to remove the library from Sononym and delete all collected data.



Locations:
Explore
The Explore tab enables you to scan the file system for samples and libraries.

The explore tab

1. Mount
Panel - shows the path and status of the selected folder
2. Sample
Count - located on the right side of the folder tree
3. Libraries - displayed on the left side of the folder tree
4. Search
results - a table containing file properties (no descriptors)
5. Convert/Switch - button to convert, or switch (if folder is already a library).

How
it
works
On first glance, the Explore tab looks lot like the Libraries tab (situated right next to it). And while that’s largely true, there are a few key
differences. First of all, the explorer is more suitable for ‘casual browsing’ as it doesn’t analyze each and every file it encounters.
Secondly, it detects and highlights folders containing libraries, and/or samples. This is useful for getting a visual overview of even the
largest file structure.

Limitations
There are a couple of important limitations to keep in mind:

The
explorer
does
not
allow
you
to
search
files
by
similarity. While you can use it to launch a similarity search, you can’t
search the folders themselves in this mode. Instead, pick your source file, and then switch to a library in order to continue your
search.

The
explorer
does
not
allow
advanced
filtering. Only filtering by search terms are supported in this mode.

Opening
a
folder
From the Explore tab, push the “Open Folder” button. Alternatively, choose “Open Folder” from the File menu, or use the
accompanying keyboard shortcut. In both cases, a system dialog will open, which allows you to pick a folder on your computer.

Once you have selected a folder, the application will start to scan the file system.

Note that folders are scanned recursively, just like a disk-scanning utility would. A cache is built the first time you open a folder, which should
result in quicker access later on.

Browsing
folders



The lower part of the sidepanel will display a tree, listing all folders and libraries, and highlighting supported files. By default, the
topmost/root folder is selected, but you can select any sub-folder to give it priority. This is handy, since a priotized subfolder will be
processed before any other folder.

Detection
of
libraries
To help you quickly determine whether and where libraries are present in the path you’re browsing, the tree contains a special popout
menu:

If the path doesn’t contain any libraries, this button will not appear.

Clicking the “+” button will display a list of libraries and allow quick switching between them (tip: Undo Query Change can be your
friend here).

Additionally, the “strip” in the left side of the folder tree highlights any indexed folders (libraries) that have been detected.

Refreshing
contents
To ensure that the entire folder structure is up-to-date, you can refresh the results via a button in the lower right corner of the status
bar. Alternatively, you can select “Refresh Results” by clicking the “gear” symbol (options), located in the topmost part of the
sidepanel.

Perhaps confusingly, there is another refresh option up there called “Hard Refresh”. Choosing this option will wipe the cache and
completely re-index the selected folder. Usually, file/folder integrity should be fine - this option is there, “just in case”.

Recent
folders
Even if the Explore tab only allows browsing a single folder at a time, you can still jump between often-used folders by heading into
the File menu and choosing “Open Recent Folder”.



Projects
The Project makes it easy to bookmark, organize and export sounds of interest.

NB: Up until Sononym 1.3, Projects were referred to as ‘Collections’. Some of the screenshots on this page are not updated to reflect this change.

List of Projects (1), Tree widget (2) and Export dialog (3)

A Project is a place to store references to sounds. You can create as many projects as you like, freely organize sounds within each
project and export them to a folder of your choice.

Projects also makes it easy to enforce a naming convention to items within the Project. For instance, you might want to tag all files
with their BPM or Pitch information. The section on renaming explains how this can be achieved.

Adding
Items
The easiest way to add an item to a project is to press the keyboard shortcut while browsing through some results. This will add the
selected result(s), using the currently
selected
path
in
the
currently
selected
project as the insertion point.

Alternatively, you can drag and drop the items manually:



Using drag and drop to add items to a project

List
of
projects
To select a project, click in the list (1)
To re-arrange the list, use drag and drop.
To view options for the project, press the “gear” symbol or right-click.

Creating
a
Project
By default, the application will start with an empty, default project, but you can always add a new one by pressing the relevant
keyboard shortcut or hitting the green “+” at the top of the projects panel.

Organizing
content
Once a project grows beyond a few items, it can become necessary to organize things a little more. Using the tree widget in lower part
of the sidepanel, this is all accomplished quite easily:

Create folders, delete, rename and assign colors to items
Multi-select (hold shift key while selecting, etc.)
Re-arrange items via drag and drop, or by using the clipboard (copy/paste).

Renaming
items
When you add an item to a Project, you are able to provide an alternative name for it without modifying the original/source file.

If you click the checkbox Advanced
Renaming, the rename dialog will expand and allow you to embed all sorts of information into the
names of your files. Advanced renaming is a big subject with its own dedicated page.

Assigning
Colors
Any item can be assigned to one of the seven available colors, but it’s up to you to decide the meaning. For now, the colors exist
merely as a way to visually distinguish between files.

Options
Dialog
To bring up the Options dialog, press the “gear” symbol or right-click (1), or press the “Options” button in the lower-right corner of the
Tree (2).

Auto-Export
Enable auto-export to automatically export the Project to a folder of your choice, every time the contents have changed.



When you enable Auto-Export, the contents of the project will be exported to a folder of your choice. This folder, by default, is located
in User Documents > Sononym.

If you want to use a different folder, click “Relocate” on the right side of the Target Folder. This will launch a file dialog asking you to
pick a different folder - and asking you to confirm the action. Once you click OK, the project is moved to the new location. In
other
words,
it’s
not
necessary
to
move
the
collection
folder
using
Finder/Explorer/Etc.

Exporting
A project is either exported automatically or manually -

Automatic Export: please see Auto-Export above.
Manual Export: either bring up the Options Dialog and hit ‘Export’, choose File Menu > Export Project or press Cmd/Ctrl+E

Importing
A project can be imported by choosing “Import Project” from the File menu. This will open a file dialog, expecting you to select a file
named project.json *. The imported project will appear in the list of projects, and should be ready to use.

*Historically, these files were named collection.json . Both file names will continue to be valid.



Renaming
Files
&
Folders
To rename a file or folder, hit the relevant keyboard shortcut or right-click and select “Rename” to bring up the Rename dialog.

This dialog will, depending on the context, provide access to different renaming “modes”:

Regular
Renaming
Regular renaming is just a basic text input that validates the input as you type.
This
mode
is
not
accessible
when
you
have
selected
multiple
files.

Batch
Renaming
You can use the batch-renaming to quickly and easily transform the name of multiple files.
This
mode
is
accessible
when
you
are
renaming
more
than
one
file.

Add Text
Select this mode to insert the specified text before or after the filename (but before the extension).

Replace Text
Select this mode to enter some text which should be replaced by some other piece of text (or simply be removed).

Advanced
Renaming
Advanced renaming can be used to “imprint” your file names with all kinds of data. It might be the tempo of a given sound, the current
time or even the name of the currently logged-in user.

To begin with, simply choose to rename one or more files. You should notice that the Rename dialog has been extended with an
“advanced” mode:

Use
Tokens
to
fetch
data

Once you enter the advanced mode, you can enter special values, so-called “tokens” into the name - each of which will embed a
certain piece of information into the filename.

Tokens can also be accessed from the popout menu on the right side of the text input.



Demonstrating how to enter a token manually, or by selecting it from the popout menu.

Underneath the text input, you’ll see a preview which updates as you type, pulling information from the file and/or library. In addition,
the preview will inform you when the input contains a syntax error or unknown value.

Use
Modifiers
to
get
the
syntax
right

You can add so-called “modifiers” to change the value of a token. For example, you might want all text to be lower-case.

Modifiers are specified by entering a colon, the name and arguments immediately after the token. And just like tokens, modifiers can
also be accessed from the popout menu on the right side of the text input.

Here we define a “replace” modifier that replace any occurrence of “foo” with “bar”:
%user:replace(foo:bar)%

Modifiers can also be chained together, simply by adding another modifier following the first one. if you specify more than one
modifier, they are parsed in left-to-right order.

For example, %user:wrap(before_:_after):upper()%  might output BEFORE_USERNAME_AFTER , as the wrapping text got transformed
into uppercase.

Token
Reference
Here are the most important tokens in alphabetical order:

Identifier Type Description

added number The time when file got added to Library/Location.

basenote number The detected pitch, expressed as a MIDI-compatible note value.

bits number The bit depth of the audio signal.

bpm number The detected BPM (beats-per-minute) of the sound.

brightness number The perceived ‘brightness’ of the sound.

categories string[] The category, or categories that were found to be the best match.

category string The primary category (shorthand for categories[0]).

channels number The number of channels present in the audio signal.

class string The primary class (shorthand for classes[0]).

classes string[] The sound class: either ONESHOT, LOOP, or a combination of both.



crest number Crest Factor describes the ratio between peak and RMS, and can indicate how ‘dense’ or ‘sparse’ a given
signal is.

favorite number Whether the file has been marked as a favorite, and when (expressed as timestamp).

filename string The filename, including extension ( file.wav ).

basename string The filename without file extension.

extname string The file extension (e.g. ‘wav’), without a leading dot.

filesize number The size of the file, in kilobytes.

filetype string The filetype / file format (e.g. ‘wav’).

folders string[] The relative path of the file within the Library.

harmonicity number The perceived ‘harmonicity’ of the sound.

hidden number Whether the file is hidden, and when it got hidden (expressed as timestamp).

host string The hostname of the computer

id number The ID of this particular sound within the Library.

length number The duration of the sound, in seconds.

library string Path/name of originating Library. Useful if content has arrived from multiple different libraries.

modtime number File Modification Date (expressed as timestamp).

noisiness number The perceived ’noisiness’ of the sound.

nowtime number The current time (expressed as timestamp)

octave number The octave value of the detected pitch.

peak number The Peak amplitude in the sound, expressed as decibel (dB).

pitchclass string The pitch class of the note, e.g. ‘C’ or ‘E#’.

rms number RMS: The average amplitude expressed in decibel (dB).

samplerate number The sample rate of the audio signal.

seq number Running sequence: see detailed description below.

status string Whether the asset was succesfully analyzed - or error message, if not.

user string The name of the currently logged in user

Identifier Type Description

In addition to the tokens above, you can include metadata by specifying the name of the metadata column, prefixed with meta:  (for
example, meta:artist ).

Modifier
Reference
Use modifiers to change the input provided by a token. If you specify multiple modifiers, they will be processed in a left-to-right order.
The modifiers are divided into three categories: numbers, strings and date modifiers.

Note: each modifier will expect either a number or string as input, but will automatically try to convert the input into the appropriate format.

Number Modifiers

Name Description

abs Returns the absolute value of a number (the value without regard to whether it is positive or
negative).



add Increase the value by the specied amount

sub Decrease the value by the specied amount

mul Multiply the value by the specied amount

div Divide the value by the specied amount

modulo Perform integer division and return remainder

range Scale the number by providing a source and target range (4 values in total)

ceil Returns the smallest integer greater than or equal to its numeric argument.

digits Returns a string representing a number in fixed-point notation.

floor Returns the greatest integer less than or equal to its numeric argument.

Name Description

String Modifiers

Name Description

lower Converts all the alphabetic characters in a string to lowercase.

upper Converts all the alphabetic characters in a string to uppercase.

lpad Pads the current string with a given string (possibly repeated) so that the resulting string reaches a given length. The
padding is applied from the start (left) of the current string. 
@param maxLength:  The length of the resulting string once the current string has been padded. If this parameter is
smaller than the current string’s length, the current string will be returned as it is. 
@param maxLength:  The string to pad the current string with. If this string is too long, it will be truncated and the left-
most part will be applied. The default value for this parameter is " " (U+0020).

replace Replaces text in a string, using a regular expression or search string. 
@param searchValue  — A string or regular expression to search for.
@param replaceValue  — A string containing the text to replace.

rpad Pad the current string with a given string (repeated, if needed) so that the resulting string reaches a given length. The
padding is applied from the end (right) of the current string.. 
@param maxLength:  The length of the resulting string once the current string has been padded. If this parameter is
smaller than the current string’s length, the current string will be returned as it is. 
@param maxLength:  The string to pad the current string with. If this string is too long, it will be truncated and the left-
most part will be applied. The default value for this parameter is " " (U+0020).

wrap Wrap the input in the provided value. If two arguments are provided, first argument is used for the left side and second for
the right side. Otherwise, the first argument is used for both sides.

Date Modifiers
These modifiers all expect a numeric unix timestamp as input (e.g. %nowtime% , %modtime% , %favorite%  and %hidden% )

Name Description

date Output the day in two-digit format (DD)

month Output the month in two-digit format (MM)

year2 Output the year in two-digit format (YY)

year4 Format timestamp as year, using 4 digit format
(YYYY)

Sequence
Files will automatically have a number (the “running sequence”) assigned to them when they are renamed. This makes it possible to



ensure that the original order is kept.

A special case here is the Project: when some files have already added to a project, and you apply a profile which makes use of the
%seq%  token, the user will be prompted if the numbering should be updated:

Naming
Profiles
A Naming Profile is a “template” which can be used when renaming files. Use it to define more complex, reusable patterns containing
multiple tokens and/or modifiers.

To
view/edit
or
create
Naming
Profiles

To view/edit/create a profile, head into the application menu > View > Show Naming Profile Editor

The application comes with a few ready-made profiles that demonstrate how the feature works. But you can also define your own
profiles from scratch, or base it on an existing profile.

To
apply
a
Naming
Profile
to
items
in
a
Project:

1. Open the Project sidepanel.
2. Select the desired items (files).
3. Click the “%” symbol to bring up the dropdown menu.
4. Select your desired profile.

To
apply
a
Naming
Profile
to
items
in
the
Browser:

1. Bring focus to the Browser (CTRL/CMD+K)
2. Select the desired files.
3. Right-click and choose ‘Assign Naming Profile’
4. Select your desired profile.

Examples
Prefix
entries
with
running
sequence
index
(3
digits)

pattern:	
		%seq:lpad(3:0)%-%filename%		

input:	
		Foobar.wav
		Barfoo.wav
		Barbaz.mp3

output
		000-Foobar.wav
		001-Barfoo.wav	
		002-Barbaz.mp3

Embed
note
information
into
filename
(octave,
pitch
class)



pattern:	
		%pitchclass:rpad(-:2)%%octave%		

input:	
		Foobar.wav
		Barfoo.wav
		Barbaz.mp3

output
		C-1.wav
		E#2.wav	
		F-4.mp3

Display
embedded
metadata
(artist/album/song
info)

pattern:
		%meta:artist%,%meta:album%,%meta:title%

input:	
		file_with_embedded_metadata.mp3

output:
		Depeche	Mode,Memento	Mori,Speak	to	Me.mp3



Favorites
Favorites are useful when you need to quickly mark a sample for later access, for example while stepping through search results.

How
files
can
be
added
to
favorites.
To
add
a
folder,
open
the
folder
tree
and
follow
the
same
approach.

How
to
add
a
favorite
Favorites can be added by using the shortcut SHIFT+F , by drag the favorites directly into the favorites side-panel, or right-click and
choose “Set as Favorite”.

You can also add folders in a library as favorites - when the folder tree is open, you can click the little star icon that appears when
hovering over a folder.

Where
to
find
favorited
files
Search
Results
While browsing search results, look for starred items in the favorite column (how to enable the column) or in the Folder Tree.

Tip: you can use sorting to make the favorites files appear at the top of the search results. To achieve this, simply click the favorite column header.

Favorites
Panel
Favorites also have a dedicated side-panel where you can do the following things:

Search
Filename
Press the magnifying glass to bring up the search input.

Options:
Sort
by
Name
/
Date
Added
/
Location
Here you can choose various ways of viewing/sorting the favorites. The default choice is “Date”, which shows the most recently added
entries at the top.

Options:
Auto-reveal
The Favorites panel is, by default, set to automatically reveal the location of the selected favorite in the browser. You can disable this
option and instead, choose to manually reveal files in the browser by right-clicking them.

Filter
Panel
Open the Filter Panel to access a simple filter for favorites.





Upper
Panel
The upper panel contains query history + playback options, and below, a waveform display.

Query History (1), Playback Options (2), Waveform Display (3)

Query
History
The two arrows situated to the left controls the query history. Think of the ‘back’ button in a browser - that is, the ability to revisit every
location and folder you have previously navigated to, or filter you have applied. Keyboard shortcuts lets you navigate the history as
well.

Playback
Options
Playback
&
Record

The first few buttons work as expected:

Play Press this button to preview the current sample,
Auto-Advance If enabled, playback will automatically advance to the next file once the current file stops playing.
Prev/Next Applies when Auto-Advance is enabled: will jump to previous or next file in the sequence.
Loop Enable this to repeat the sample indefinitely.
Stop Pressing Stop (or ESC) will immediately stop playback.
Record Press this button to capture line input (e.g. a microphone, synth or any other sound source) and use this as the source
for a similarity search. The recording process can be aborted at any time by pressing Cancel, Stop or by hitting Esc.

Auto-Advance is restricted to your selected files, when more than one file has been selected.

Recordings are automatically saved in the Sononym documents folder. Your recordings will also automatically become part of the Query History,
so you can do any number of takes, and use the previous/next buttons to switch between your takes.

Check the keyboard shortcuts associated with these buttons.

Pitch
Control
A simple pitch control, allowing four octaves transpose.



Click-and-drag to change the pitch
Double-click to edit transpose.
Use Mouse Wheel to change value in semitone increments

Pitch
Lock: When a sample is selected, the pitch control contains an option to “lock” the pitch. This will attempt to maintain the pitch
of the file you have selected, as you step through/select other files. How well this works, depends on how accurately the application
was able to detect the pitch in your sounds.

Volume
Control
Should be self-explanatory, a volume control which works in the decibel (dB) range.

Auto-play
This option will decide whether files are automatically previewed when selected. If you disable this option, you can still use the
preview button (in search-results), the context-menu options or keyboard shortcut to trigger a preview.

Any active playback can be interrupted by pressing the escape (ESC) key while a relevant panel is focused
See also: keyboard shortcuts

Other
playback
options
Sononym comes with a number of additional playback options, which can be configured through the Playback menu:

Play
Selected
File : works the same as pressing Space
Play
Similarity-Src
File : when in similarity search mode, this will preview the source sound
Play
Random
File : this one will select a random file in the results and play it. Switches to “weighted” randomness when the
results are filtered by a category, or you are in similarity-search mode (basically, it will prefer results that are higher up the list)
Stop
Playback/Recording: : forces the current playback and/or recording process to stop
Toggle
Loop : toggle the loop mode
Toggle
Recording : toggle the recording mode
Play
Keyboard
Shortcut
Behavior: : here, you can decide how the default shortcut will operate - there are three choices,
Start/Retrigger , Start/Stop  and Start/Pause/Resume .
Suspend
Playback
while
App
Doesn’t
Have
Focus : here you can decide if active playback should be suspended (paused) as
focus leaves the application. The suspended sound will resume playing once the application regains focus.
Stop
Playback
when
Dragging
File: Enable this option if you want playback to stop as soon as you start to drag a file.

Waveform
Display
In normal use, the waveform display shows the currently selected file, with the name visible as a label in the upper right-hand corner.
While searching for similarity, two waveform displays appear, with the upper one showing the similarity source.

In similarity search mode, two displays are stacked on top of each other

Click a waveform to play it, or press the play button to the left (or Return) to play from the beginning. The Left and Right arrow keys
can be used for “scrubbing” through the file. And as always, hitting Escape will stop the playback.

Creating
a
selection
Simply press the waveform and drag to create a selection. Dragging along either edge will allow you to resize the selection, and
dragging along the top will allow you to move the entire selection:

And of course, selections will also affect how playback works. For example, playing a looped sample will respect the selection



boundaries - also while they are dragged around.

Note: a couple of keyboard shortcuts have been introduced, to enable previewing of the entire file or just the selection. Please see Sample
Playback for more information.

Search
for
similarity
to
the
selected
audio
If you want to search for similarity to e.g. a single snare hit within a loop, simply drag to select the desired part and right-click, or click
the similarity icon in the top right corner:

Create
a
selection
in
a
sample
and
drag
it
somewhere
else.
The selection can also be dragged into your DAW, or any other application that accepts audio files.

To crop the sample on-the-fly, simply position your mouse over the the selection and drag it into your desired spot. You can also drag
it straight into a Sononym project using this approach.



Search
Input
Provides access to the current path, and allows entering custom search terms.

Where to find the search input

Anatomy

An example path with some search terms

The path is relative to the root of the current location, and ends with a forward slash.
The location determines the root path, no matter if you are browsing a library or a folder.

The search
term is any text following the path. Once you enter anything, only the results whose name is a (partial or full) match of the
term you’ve entered will be included.

Keywords are suggested search terms, extracted from the results (more info).

Excluded
Terms
When entering search terms, you can also specify that a term should be used to exclude search results. It’s simple to use: simply
prefix any word with a minus “-”, and the application will only return results that does not match that term.

For example, to search for sounds containing the term “hoo” without matching “hooray”, enter the following:

Of course, you can still search for a word that starts with a minus too - just surround the term with quotes to enforce a literal search:

Keywords
Keywords are terms that have been statistically extracted from the pool of names available in the current set of search results. As
such, they are very dynamic and will (most likely) change as you switch between folders.

The suggestions are available as ‘floating’ buttons, in the right-hand side of the text input. Since there is only room for a few



suggestions there (and there might be many), keywords are also used for providing suggestions while you are typing.

Suggestions
While you are typing in the search input, the software will show you matching paths or keywords:

Entering search terms with auto-complete

You can apply those suggestions by hitting either TAB, or by pressing the Right Arrow key. You can also cycle between the available
suggestions by pressing the Up/Down arrow keys.



Search
Results
Search results are shown in a large table with each column representing a property or descriptor.

Showing search results from the selected library

The results you are seing arrives from either a library, or the explore tab. It’s easy to tell that you are browsing a library, as all columns
(all audio descriptors) are available to those.

Selecting
and
navigating
The table supports both single and multi-select. This allows you to select one or more items, e.g. to drag them into a project. To learn
the shortcuts for (multi-)select and navigating the table, please read about the available keyboard shortcuts.

Whenever you select a sample, it is shown in the waveform-panel. Also, if you have enabled auto-play, the selected file will
automatically be previewed.

Scrolling
Vertical - Use the mouse wheel, keyboard shortcuts, or touch swipe to scroll through results.
Horizontal - Use the mouse, keyboard (arrow keys) or touch swipe to step sideways through the available columns. Note that the first
column (Filename) is fixed when scrolling horizontally.

Sorting
results
Each column can be sorted by clicking the column header.
It works like you would expect, with one exception: in similarity search mode, only the similarity columns are sortable.

Hiding
results
If you come across some audio files that won’t be needed, but also shouldn’t be deleted, you can mark such files as “hidden”.

Simply right-click the files, or use the provided keyboard shortcut to hide them. Once hidden, they won’t appear in search results until
you choose to make them visible by means of the Hidden Files filter.

Assigning
values
If a file seems to have the wrong BPM or an inaccurate note assigned to it, this is easily fixed: simply hover over the relevant table cell
and click the little icon that looks like a pencil. This will allows you to pick an appropriate value:



And should you need to change values for multiple results, the menu you see in the screenshot above is also accessible from the
regular context menu. Look for “Assign Note”, “Assign BPM”, and so on.

Shuffle/randomize
When you’re always revisiting the same old folders again and again, enable the Shuffle Mode to see a freshly randomized set of
results every time:

Note: if you choose to sort by a column (e.g. filename) or start a similarity search, the shuffle mode is temporarily disabled.

Also, don’t forget that Sononym has a random preview feature, which selects (and plays) a random file from the current set of results.

Row
Options
Each row in the table contains two buttons: the small circle will launch a similarity search and the play button will preview the sound.

Right-click any item to bring up a menu with the available options. This includes the ability to add the item to a(ny) project, reveal the
location in Explorer/Finder, and more.

Note also that you can adjust the height of table rows in the Display Configuration



Column
Options
Right-clicking any column-header will bring up a menu where you can decide which columns to show:

Showing the context menu listing all regular columns

The menu is also available from the application menu > View > Columns.

The Column Options menu also includes all metadata tags - but since there are many possible entries, we decided to structure the
menu like this:

All
columns - all types of metadata, including rare/unusual ones.
Commonly
Used - the most commonly used types of metadata (artist, genre, etc.).
Actually
Used - the actually used metadata within the selected library.

Table
Layout
Note: changes to the table layout will create new entries in the Query History.

Pinning
and
Unpinning
Columns: By default, the Path and Favorite columns are fixed on the left-hand side of the table. You
can change this by right-clicking a column and choosing ‘Pin This Column’ to either pin or unpin the column.
Reordering
Columns: If you want to reorder columns, simply click a table header and drag it sideways until the desired position
has been found.
Reset
Table
Layout: To reset your modifications to the table layout, you can click the table header and choose “Reset Column
Layout”.

See
also
Descriptors - how to interpret each of the columns in the results table
Searching - using free-text terms to search among results
Filtering - defining advanced filters for narrowing down results



Similarity
search
When entering similarity-search mode, additional elements will appear in the user interface:

1. Source
File - waveform panel is split in two, upper part shows the source file.
2. Aspects
Dial - allow you to finetune the behavior of the similarity search.
3. Filter
Banner - tells you the name of the source file, as well as any other active filters.
4. Similarity
Ratings - tell you how much each result is matching the source file.

Aspects
Dial
The Aspects Dial allows you to finetune the search algorithm

Using the dial, you can increase, decrease, or completely disable any of the search aspects. Changing a value will force the search
results to be recalculated.

How
it
works
Similarity search works by comparing aspects in the source file against other files.

Overall  - Matches sounds by a broad range of criteria. This aspect is designed to give reasonably good results without the need for
further adjustments.

Spectrum  - Think of the spectrum as a snapshot of the sound, capturing the frequencies and movement over time. Works well in
combination with Overall similarity, but is more concerned with the temporal quality.

Timbre  - Timbre (pronounced ‘tam-brah’) describes the “character” of the sound - also, often referred to as the “color”. It’s a very
dynamic quality that can be drastically influenced by other aspects, such as pitch and amplitude.



Pitch  - The perceived frequency of the sound. Use the pitch aspect to match other sounds with a similar frequency - either fixed,
sustained notes, or one that develops over time, such as the sound of a wailing siren.

Amplitude  - The perceived “loudness” of the sound. Use the amplitude aspect to match other sounds with a similar loudness (either
fixed or developing over time). For example, if the source was a sound that gradually builds in volume, it could match other sounds
with a similar amplitude profile.

Similarity
Ratings
These columns tell you how much each result is matching the source file across the various aspects.

Example of similarity ratings

For example, if a particular result had a very strong match in the Spectrum , this would be indicated with a strong yellow color. If the
result happened to have a strong Overall  match as well, the green color would be strong too. The column called ‘Similarity’ simply
provides the average of all these ratings. This column also provides the default sorting order for similarity search results, but you can
sort the results by any aspect you want.

Note: while similarity-search is active, regular result-columns can no longer be sorted. If you try, you will get a warning.
As it’s hinted in the error message, you can instead use filtering to narrow down results.

Initiating
a
search
A similarity-search can be launched in a number of ways. In fact, the whole software has been built ‘around’ this feature, to ensure
that it’s never far away.

From
your
desktop,
or
other
application

Drag an audio file on top of the application.
Assumes
that
the
file
is
in
a
supported
format

From
the
results-table

Right-click a result and choose ‘Search By Similarity’.
Click/tap the small “dial” on the left-hand side of each file.
Drag the file on top of the waveform-panel.

From
the
waveform-panel

Click/tap the small “dial” in the top-right corner.
Note
that
the
symbol
is
only
visible
when
the
file
is
not
already
the
source
of
an
existing
similarity-search

From
a
Project

Right-click an item and choose ‘Search By Similarity’.
Drag it on top of the waveform-panel.

Exiting
the
search
Once you have started a similarity search, it can be exited in the following ways:

From
the
results-table: right-click a result and choose ‘Exit Similarity Search’
From
the
aspects-dial: click the ‘X’ icon in the upper right corner of the panel.
From
the
waveform-panel: right-click the name/label



Duplicate
Detection
Duplicate-detection can be used for hiding duplicate content in your libraries, and to free up disk space on your computer. If you like
the idea of having smaller and more focused sample libraries, continue reading…

How
it
works
Unlike a traditional “duplicate file checker”, Sononym is capable of identifying sounds that are identical, but also sounds that are
nearly identical. So you happen to have a lot of sounds encoded in different formats (say, .aif and .wav), you can use this feature to
identify those files, and take some kind of action on them.

Our approach - using the “audio descriptors” that Sononym collected while creating your libraries - means that searching for
duplicates of any given file is nearly instantaneous. But it should also be noted that the tradeoff is that such quick matching isn’t
always perfect - occasionally, the search might deliver a result that isn’t a duplicate. See Known Limitations below for more
information.

Step
1:
Launching
The
Duplicate
Checker
The detection process is easy to launch:

Right-click a sound to find duplicates of that specific sound in other locations.
Right-click a folder (or library) to find duplicates within that location.

Once you select launch a search, the following dialog appears:

The dialog is divided into three logical sections:

Where
to
look: this section determines the source location for the search. The location can be a single folder, an entire library or even
multiple libraries. To change the current location, click ‘Refine’.

What
to
look
for: if you have launched the search on a folder or library, the default choice is to detect duplicates within that location.
If you launched the search to look for one or more specific sample(s), their paths are listed here.

‘Include hidden files’: instructs Sononym to include previously hidden files in the search.

What
to
do: here you can determine the default action to take for duplicate items. The available options are:

Hide Duplicate Entries
Link Duplicate Entries To Source
Delete Duplicate Entries (Move To Trash)



Once you are happy with the settings, you can click ‘Start Search’. Immediately, a dialog should appear which displays the search
progress.

Step
2:
Search
Results
&
Actions
Search results are shown in a list which is continuously updated while the search is running.

By default, the dialog has a relatively compact size, but you can click the icon in the upper-left corner to maximize it. Apart from
offering more horizontal space for file paths, maximizing the dialog will also reveal a waveform display at the top.

In the middle of the dialog the search results are located. The results are organized into “sets”, comprised of sounds that are
considered duplicates. Each of the sets can be collapsed and expanded by clicking the icons on the left-hand side, or by using the
keyboard shortcuts.

Note that you can always close this dialog and let the search continue in the background. This might be useful if the search takes a while to
complete.

Got Duplicates? Now Do Something With Them!
Once results start to appear, you can specify what action to take. By default, the action will be the one you picked before starting the
search (Hide/Link/Delete), but you can change these actions at any time by clicking the action button.

If you do, a menu will appear containg these options:

Keep: Simply means “keep this file around, and don’t take any action”. Usually, this is the action assigned to the topmost item in
a set.
Hide/Unhide: Will decide the hidden state of the sample within the Sononym library without modifying the physical file.
Link/Unlink: Will replace the source file with a symbolic link, or vice versa (more info below).
Delete: Move the specific file to the trash.
Use
As
Link
Target: Manually specify which file should be used as the source when creating links.



Note that some of the options might not be available at all times. For example, only a file which was previously hidden can be
unhidden.

Regarding
Symbolic
Links: By replacing files with symbolic links, you can potentially save disk space without deleting any files. Still, it’s worth
pointing out that this is a relatively advanced feature - not all filesystems support symbolic links, and on Windows, you might need to take the
additional step of launching the application in “Administrator Mode”.

Additional Actions
In addition to the standard actions, the actions menu contains a couple of more specialized actions:

“Prefer to keep files matching this file extension”
“Prefer to keep files from this folder”

These actions cater to a couple of special scenarios. Imagine that you’d want to prioritize a specific file extension over another one?
Or that your library contains a copy of another folder, and you want only one of these folders to remain visible? In both cases, clicking
the action will show an additional dialog with more information.

For example, here’s what we might see if we decided to “prefer” a different folder:

As you can see, the dialog allows you to specify a different folder. This can be important when the file itself was located deep in a
folder hierarchy, and you want to pick one of its parent folders. If you do, the preview will immediately be rebuilt to reflect the changed
folder.

Worth knowing:

When you choose to prefer a folder or extension, this choice will be applied as results arrive (while the duplicate detector is
running). Only once you start a new search, your choice of preferred folders or extensions will be reset.
Multiple preferred folders or extensions can be defined simultaneously, and will be applied in the order you defined them.

Step
3:
Applying
Actions
to
Results
Once the search is complete, a panel will appear below the search results containing one or more buttons. These buttons will allow
you to actually apply the actions you have specified. Trying to close the dialog at this point will remind you of that no actions were
applied.

Additionally, you might notice that each button has a small arrow on the left side - clicking this will allow you to remap the action into
a different type of action (changing all occurrences in the results).

Finally, in case the duplicate checker detected any issues/inconsistencies in the results, the panel will feature an additional button
which, when clicked, will show a list of all the issues and suggest possible workarounds.

Known
Limitations
Embedded metadata is ignored
Metadata, such as “Artist”, “Year”, “Genre”, etc. is currently NOT considered when comparing the files. So, if you have a number of
identical files, but each one tagged with varying information, this is simply ignored.



False positives
Every now and then, it’s possible that the duplicate checker deliver results that aren’t really identical. More specifically, we found that
sounds with swapped channel content and multichannel-to-mono mixdowns can “slip through” the detection algorithm. We are
working to improve this aspect of the duplicate detector.



Filtering
Narrow down the number of results by applying filters to the search

The filter-banner (1) and filter-panel (2)

Imagine that you start Sononym and select the root path of one of your sample libraries - without filtering, the software will simply
show all files contained in the library. If you then select a subfolder, you will see all files contained within that folder, and so on. What
you are doing is essentially filtering: the process of eliminating results by specifying some kind of criteria.

Navigating through folders is intuitively controlled by using the Location file tree and via the Search Input. But there are several other
filters that can make your results more specific and relevant - all contained within the Filter Panel.

Filter
Banner
The Filter Banner is the narrow strip between the search input and the results table, which contains all active/applied filters.

To the left, you can click the text of each individual filter to highlight/focus the relevant part of the interface, or click the small “X” to
remove that particular filter.

To the right, a button (Reset All Filters) allows you to remove all active filters in one go.

Clicking the filters will highlight relevant parts of the interface

Filter
Panel
The filters are located in the panel just below the search results. The panel can minimized, enlarged and freely resized. Clicking any
tab will take you to the relevant sub-panel. Double-clicking the name will toggle the visible state of the panel.

General
This panel contains filters that deal with user-specified properties.



Favorites: this filter will allow you to (A) exclude or (B) include (only) favorited items in the search results.
Hidden files: this filter will allow you to (A) show only hidden files or (B) include them in the search results (temporarily “unhide”
them).

Here, the Hidden Files filter has been configured to show hidden files. But the default (disabled) setting for this filter will actually hide
the files completely.

Note that changing the hidden state of a file in Sononym won’t affect its hidden or visible state in your file-system. It’s purely a feature that applies
to search results within our sample browser.

Categories
The category-filter allows you to filter search results by category and class.

Selecting any of the categories will sort the results by relevance - meaning that the topmost results will now be the ones that
Sononym thinks are the best match for the selected category(-ies): the most “kick-alike”, “snare-alike”, and so on. If you then sort the
search results by some other criteria (for example, by Brightness), you can reinstate the “sort by relevance” by clicking the sort button
(3:TODO). Note that this button is only visible while this filter is active but results are sorted by some other criteria.

When a given category appears “dimmed”, Sononym didn’t find any sounds in the library featuring that category as the primary
prediction.

Tip: if you’d always like to select a single category at a time (the “old” approach), you can right-click the categories.



Oh, and let’s not forget about the two buttons on the right-hand side: ONESHOT and LOOP. They filter by class instead of category,
but otherwise the functionality is largely identical; selecting ONESHOT will display the most oneshot-alike sounds from all categories,
while LOOP will provide you with the sounds best matching a loop.

See also Classes & Categories for more information

File
info
This panel collects multiple filters that deal with file properties: the length of the audio, the samplerate, number of channels and bits.
Each filter can be controlled individually of one another.

See also file-info descriptors

Loudness
This panel consists of three individual filters that all deal with loudness in some way: Peak, RMS/dB and Crest Factor.

You can type values while the slider is focused. More info

Note/Frequency
This panel allows you to define a range for the Note/Frequency. It has three modes:

Note: allow you to enter a specific pitch class (e.g. “F”), regardless of the octave.
Note-range: allows to you define the range as (MIDI-compatible) note values.
Hz-range: allows you to specify the range using Hz

You can type values while the slider is focused. More info

BPM/Tempo
This panel allows you to define a range between 50 and 250 BPM. Use it to isolate sounds with a specific tempo.

You can type values while the slider is focused. More info
See also BPM/Tempo descriptor

Brightness
This panel allows you to restrict the results to those that match a specific Brightness, between 0% (very dark) and 100% (very bright).

You can type values while the slider is focused. More info
See also Brightness descriptor

Harmonicity
This panel allows you to restrict the results to those that match a specific Harmonicity, between 0% (dissonant) and 100%
(harmoneous).

You can type values while the slider is focused. More info
See also Harmonicity descriptor

Noisiness
This panel allows you to restrict the results to those that match a specific Noisiness, between 0% (clean sounding) and 100% (noisy).

You can type values while the slider is focused. More info
See also Noisiness descriptor

Controlling
sliders
Several of the filter panels are using a range slider to control the filter. This type of slider can be controlled the keyboard, which
sometimes offer more accuracy and faster input than when using the mouse. For example, you can enter values directly by typing
while the slider is focused. If the value is recognized, the slider will immediately be updated.

Try it yourself: head into one of the filter panels, e.g. “BPM”. Make sure the filter is enabled (that the ON button in the top-left corner is
enabled). Then, click one of the slider “arrows” to bring focus to the slider. Now, you can enter numeric values to control the value of



the slider. Next, try pressing TAB (or Shift+TAB) to move focus through the various slider controls, and notice how you can set both
the minimum and maximum value at the same time.



Descriptors
All available audio/file descriptors, appearing as columns in the search results table.
NB: Not all columns are visible by default - Column Options lets you change this.

Name Description Filter

Path The full path (including filename) within the Library. Search Input

Library The name of the Library. Useful if content have arrived from [multiple different libraries](). Search Input

Folder The path within the Library, relative to the selected folder. Search Input

Filename The filename, including extension. Search Input

Date
Modified

The "modified" attribute of the file (updated when library is refreshed). -

Date Added The time when the file got added to the library (e.g. as part of a refresh operation). -

Class The sound 'class': ONESHOT , or LOOP

ONESHOT represents percussive and non-repeating sounds. LOOP are repetitive in nature. Note that if
more than one class is present, the secondary prediction will appear slightly dimmed. See also Classes for
more information.

Categories

Categories The category, or categories that were found to be the best match. 

Note that categories only applies to ONESHOT sounds. If more than one category is present, secondary
categories will appear slightly dimmed. See also Categories for more information

Categories

Length The total duration (playing time) of the sound.

The value is expressed as minutes:seconds:milliseconds

File Info

Samplerate The samplerate of the sound, e.g. 44100 for CD-quality audio. File Info

Channels Number of audio channels in the source file. File Info

Bits The bit-depth of the source file, e.g. 16 or 8-bit . File Info

Peak The peak amplitude in the sound, expressed as decibel (dB). Loudness

RMS The average amplitude (RMS) expressed in decibel (dB). Loudness



Crest
Factor

Crest Factor describes the ratio between peak and RMS, and can indicate how "dense" or "sparse"
a given signal is.

Here are some concrete examples:

A single loud peak in a otherwise quiet sample leads to very high crest factor.

A sparsely populated rhythm is considered a high crest factor.

Dense rhythm leads to a medium-low crest factor.

A constant tone, almost without dynamic variation. This will always lead to a low crest factor, no matter
how loud the actual audio is.

Loudness

Pitch Class The 'pitch class' of the note, e.g. C  or G# .

Use this column to sort files by their note value, irrespective of the octave.

-

Note The percieved pitch expressed as a MIDI-compatible note value

The small number to the right of the note is the detuning amount in cents. For example, a note value such
as C1  should be understood as a C1  tuned approximately 22% downwards toward B-0 . Note also
that tones that are tuned more that halfway up or down (50%) will instead be shown as the neighbouring
tone. So a C-1  would be 'relabelled' as C#1

Note/Frequency

Note-conf. The 'note confidence'

A small number usually indicates that the sample is dissonant, or contains complex/modulating harmonics
that are not easily resolved into a single note value.

Note/Frequency

BPM The detected BPM (beats-per-minute) of the sound. 

The tempo is not necessarily available for all sounds.

BPM/Tempo

BPM-conf. The 'tempo confidence'

a low value indicates that the tempo was found to be unstable.

-

Brightness The perceived 'brightness' of the sound

A value of 100 is very bright, while 0 is the opposite - a 'dark' or 'dull' sound.

Brightness

Name Description Filter

-22

+75 -25



Harmonicity The perceived 'harmonicity' of the sound

This is a measurement of the distribution of harmonic partials, with 100 being a perfect distribution and 0
considered a very dissonant sound. Note that this is not an indication of whether a sound should be
considered 'tonal' or not - aiming for a low 'noisiness' is often a better approach here.

Harmonicity

Noisiness The perceived 'noisiness' of the sound

This value indicates how 'noisy' the sound appears to be, with 100 being very noisy, and a value of 0
being the opposite. Or in other words, if your sound has a low noisiness, it's probably closer to a sine
wave than white-noise.

Noisiness

Name Description Filter



Embedded
Metadata
Support
Sononym is able to display and search through embedded metadata from your samples - genre, artist name, track title, that sort of
thing.

Supported
Formats
These are the supported metadata formats:

APE
ASF
EXIF 2.3
ID3: ID3v1, ID3v1.1, ID3v2.2, ID3v2.3 & ID3v2.4
iTunes
RIFF/INFO
Vorbis comment
AIFF

Searching
Data
Full metadata search is enabled by default, and can be controlled by clicking the “magnifier/loupe” icon on the right side of the search
input:

When enabled, typing something into the search field will search all the available metadata in addition to the filename/path.

Displaying
Data
Different types of metadata can be shown in the search results by right-clicking the table header. But, since there are many possible
entries, we have decided to structure the menu like this:

All
columns - all types of metadata, including rare/unusual ones.
Commonly
Used - the most commonly used types of metadata (artist, genre, etc.).
Actually
Used - the actually used metadata within the selected library.

Pictures
(Cover
Art)
The metadata can also include cover art, which can be viewed/accessed by making the “Picture” column visible, and clicking any link
therein. This will display the picture in a popup dialog.

Alternatively, you can enable the Cover Art Panel (application menu > View > Cover Art) to view the cover art as a miniature picture
next to the waveform:



This screen recording shows how embedded pictures can be viewed/accessed.

Metadata
Panel

The Metadata Panel contains every metadata property (artist name/year/etc.), easily accessed from a tree structure. To filter for a
particular property, just click it - or hold Cmd/Ctrl  to toggle multiple properties.

Panel
Options

Show
Metadata Decide if you want to show all properties, or just the ones that are actually in use.
Sort
Metadata Decide how to sort entries: by name, or by number of occurrences.
Fixed
Order
For
Topmost
Entries By default, the sorting order will only affect the values within a given branch. Disable this
option to include the branches themselves.

Recognized
Tags
Here are all the metadata tags that Sononym can display/search through.

Each of these properties can appear as a column in the search results table by opening the Column Options, or be referenced by Advanced
Renaming

Name Description

track Track number on the media

disk Disk or media number

year Release year

title Track title

artist Artist, maybe several artists written in a single string

artists Track artists, every artist in the recording



albumartist Track album artists

album Album title

date Release data

originaldate Original release date

originalyear Original release year

comment List of comments

genre Genre

picture Embedded album art

composer Track composer

lyrics Lyrics

albumsort Album title, formatted for alphabetic ordering

titlesort Track title, formatted for alphabetic ordering

work The canonical title of the work

artistsort Track artist, formatted for alphabetic ordering

albumartistsort Album artist, formatted for alphabetic ordering

composersort Composer, formatted for alphabetic ordering

lyricist Lyricist(s)

writer Writer(s)

conductor Conductor(s)

remixer Remixer(s)

arranger Arranger(s)

engineer Engineer(s)

producer Producer(s)

djmixer Mix-DJ(s)

mixer Mixed by

technician Technician who digitized subject

label Release label name(s)

grouping Content group description. Used to group track titles in sections.

subtitle Contains the subtitle of the content

description Description

longDescription Long description or synopsis

discsubtitle The Media Title given to a specific disc

totaltracks The total number of tracks

totaldiscs The total number of discs

Name Description



movementTotal The total number of movements

compilation Is part of compilation (unofficial iTunes Compilation Flag)

rating Rating score and, optionally, source (e.g. user e-mail)

bpm Beats Per Minute (BPM)

mood Keywords to reflect the mood of the audio, e.g. ‘Romantic’ or ‘Sad’

media Release format, e.g. ‘CD’

catalognumber Release catalog number(s)

tvShow TV show title

tvShowSort TV show title, formatted for alphabetic ordering

tvSeason TV season title sequence number

tvEpisode TV Episode sequence number

tvEpisodeId TV episode ID

tvNetwork TV network

podcast Podcast

podcasturl Podcast URL

releasestatus Releases status, e.g. ‘Official’, ‘Promotion’ or ‘Bootleg’

releasetype Release type, e,g,: Album

releasecountry Release country describes the country in which an album was released.

script Release Script

language Language used in metadata

copyright Contain copyright message for the copyright holder of the original sound, begin with a year and a
space character.

license License Relationship Type (releases, recordings)

encodedby Encoded by (person/organisation)

encodersettings Encoder Settings

gapless Gapless album indicator (MP4)

barcode Release barcode.

isrc ISRC

asin Amazon Standard Identification Number (ASIN)

musicbrainz_recordingid Release recording MBID

musicbrainz_trackid Release track MBID

musicbrainz_albumid Album (release) MBID

musicbrainz_artistid Track artists MBID

musicbrainz_albumartistid Album artists artists MBID

musicbrainz_releasegroupid Release group MBID

Name Description



musicbrainz_workid MusicBrainz’Work MBID

musicbrainz_trmid TRM (TRM Recognizes Music) IDs were MusicBrainz’ first audio fingerprinting system.

musicbrainz_discid Disc ID is the code number which MusicBrainz uses to link a physical CD

acoustid_id MusicBrainz’ third and most recent audio fingerprinting system.

acoustid_fingerprint AcoustID Fingerprint.

musicip_puid PUIDs were MusicBrainz’ second audio fingerprinting system.

musicip_fingerprint MusicIP Fingerprint

website URL of website

performer:instrument Performer relationship types, instrument can also be vocals.

averageLevel Average gain level.

peakLevel Peak gain level.

notes Similar to comments

key The initial key of the music in the file, e.g. ‘A Minor’.

originalalbum Original release title of the earliest release in the release group intended for the title of the original
recording.

originalartist Original track artist of the earliest release in the release group intended for the performer(s) of the
original recording.

discogs_artist_id Discogs artist ID

discogs_release_id Discogs release identifier

discogs_label_id Discogs label ID

discogs_master_release_id Discogs master release ID

discogs_votes Discogs votes

discogs_rating Discogs rating

replaygain_track_gain_ratio ReplayGain track gain: {ratio: number, dB: number}

replaygain_track_peak_ratio ReplayGain track peak: {ratio: number, dB: number}

replaygain_track_gain ReplayGain album gain: {ratio: number, dB: number}

replaygain_track_peak ReplayGain track peak: {ratio: number, dB: number}

replaygain_album_gain ReplayGain album gain: {ratio: number, dB: number}

replaygain_album_peak ReplayGain album peak: {ratio: number, dB: number}

replaygain_undo The global gain adjustment to restore the original values in the left and right channels, respectively,
followed by an indicator of whether to wrap

replaygain_track_minmax Minimum & maximum global gain values across a set of files scanned as an album.

category Podcast Category

hdVideo iTunes Video Quality (2=Full HD, 1=HD, 0=SD)

keywords Podcast Keywords

movement Movement

Name Description



movementIndex Movement Index/Total, e.g. {no: 1, of: 4}

podcastId Podcast Identifier

showMovement Show Movement

stik iTunes Media Type (1=Normal, 2=Audiobook, 6=Music Video, 9=Movie, 10=TV Show, 11=Booklet,
14=Ringtone)

Name Description



Tagging
Introduction
Tags can help to organize your content. They are small text labels that you can freely associate with your files to describe something:
perhaps the music genre, the mood of a given sound - anything, really.

When you use Sononym, you will find that it comes with thousands of pre-defined tags. These tags are used for tagging your content
automatically, and for providing a solid starting point for your own tagging. And of course, you can create additional tags as needed.

Here is a quick overview of the most important terms and concepts while working with tags.

Custom
Tag: A tag which has been created by the user.
Manual
Tag: A tag which has been manually assigned to a file.
Auto-Tag: A tag which has been assigned automatically.
Group
Tag: A type of tag that can act as a container for other tags, but not be assigned on its own.
Hidden
Tag: A hidden tag works like any other tag, but will not be displayed in the search results.
UCS
Category: A tag which also defines an UCS category.

NB: the tagging feature is only available for Libraries, not in Explore mode.

How
Auto-Tagging
Works
Automatic tagging is using the information available in the filename to assign tags. For example, a file called “shotgun_reloading.wav”
might suggest topically related tags such as “Gun Handling” and “Shotgun”.

Also, the tagging system tries to determine if a given sample is a foley/sfx sound, an instrument or something else. After all, “kick” can
refer to a drum kick (instrument), or someone practicing martial arts (foley), or perhaps playing football (again, foley). So the system
has this concept of different “domains”, and tries to figure out which one any given sound belongs to.

Additionally, the built-in tags contain rich descriptions, and most of the tags define several variations of their keyword. For example,
“Guitar” alone comes with more than 50 variations/synonyms.

If you do not feel that auto-tags are beneficial, they can be disabled from the Tag Options.

Assigning
Tags
You can manually assign tags to your files by:

1. Dragging
files
onto
the
Tag
Tree. It’s intuitive to use - just don’t drag your sounds onto a group tag: such tags are not
assignable.

2. Selecting
files
and
then
bringing
up
the
Tag
Assigner. This is the most efficient option, especially when you are familiar with
the keyboard shortcuts.

Creating
Tags
There are two different approaches to creating new tags:

1. Using
the
Tag
Assigner. When the Tag Assigner dialog is open, you can type a name in the text input. If the name isn’t already
assigned to a tag, you can choose to create (and assign) the tag in a single operation.

2. Using
the
“Create
Tag”
dialog. Click the “plus” icon in the Tag Panel to launch the Create Tag dialog.

Using
The
Tag
Assigner
Bring up the Tag Assigner to assign tags to files, remove assignments from your files, and to copy/paste tags.



The dialog can be launched in the following ways:

By selecting one or more files in the Search Results, and then hitting the keyboard shortcut Ctrl/Cmd+T .
By right-clicking in the search results to bring up the context-menu, and then selecting “Assign Tags…”.
By clicking the little “pencil” icon inside the tag column. NB: this will restrict the Tag Assigner to that file only.

When using the Tag Assigner, you might see a list of tags. These are all the tags assigned to the selected files. And as you might
notice, there are subtle differences in how these tags are rendered:

A dotted
outline tells us that the tag is not assigned to every selected file.
A dimmed
tag is an auto-tag. If not dimmed, the tag has been manually assigned.
A light
pink tag is a UCS category (with the option to highlight such categories turned on)

Copying
And
Pasting

In the Tag Assigner, you can select tags and choose to copy them. This will put the tags on a clipboard, used exclusively by the Tag
Assigner.
Once that clipboard has some content (tags), the “Paste” button will also become functional. And, as you might expect, pressing the
button will cause the tags on the clipboard to be assigned to the selected files.

If you copy and then paste an auto-tag, it will become a manual tag. If you remove an auto-tag assignment, the tag will not re-appear for that
particular file if you should choose to refresh the auto-tags.

Tag
Tree
(Panel)

This panel provides a hierarchical overview of all the available tags. For example, “Guitar” is found under “Plucked String”, which in



turn is found under “Instruments”.

Conceptually, the tag tree works much like the folder tree: when selecting a tag, its children are implicitly matched as well. And
similarly, on the right-hand side, a small number specifies how many files are assigned to each tag.

But there is one major difference: while the folder tree doesn’t allow you to select multiple folders, the tag tree does: simply use the
Ctrl/Cmd  modifier while selecting tags.

When multiple tags are selected, the filter will either search for files containing all selected tags (Narrow mode), or files which has at least one of
the selected tag (Wide mode). This can be controlled from the Tag Filter Options.

It’s also worth noting that, in the Tag Tree, all top-level tags (Instruments, Sound Effects, and so on) are in fact group tags. These tags
are easily distinguished by their symbol, which looks like a folder.

Searching
the
tree

The tag tree itself can be searched/filtered by clicking the magnifying glass in the panel header, or pressing Ctrl/Cmd+S  while the
panel is focused. When searching for matches, synonyms are searched as well (this might not be immediately obvious, as the alias
itself is not shown).

Please note these special search terms:

is:custom : limit tree to custom tags
is:ucs : limit tree to UCS categories

You can combine the special search terms with regular search terms. In other words, entering is:custom	foo  will search for custom
tags which contain “foo”.

Create/Edit
Tags
The following dialog will appear when you are creating a new tag, or when editing an existing tag.

The dialog allows you to specify the properties of the tag.

Name: What name to assign to the tag. Note: used by auto-tagging.
Path: Where to store the tag within the tag hierarchy.
Description: Shown as tooltip, and in the tag tree.
Group
Tag: Decide whether the tag is a group tag.
Is
Hidden: Decide whether the tag is hidden

Worth
knowing
about
hidden
tags

A hidden tag works like any other tag, but is hidden in the search results.
All child tags of a hidden tag will become hidden too.
The only tag which is hidden by default is Manufacturers .

Tag
Options
The tag options is found in the upper right corner of the tag panel:



Tag Filter Options
These options apply when multiple tags are selected

Narrow
Mode: When active, search for files containing all selected tags
Wide
Mode: When active, search for files which has at least one of the selected tag.

Other options
Include
Auto-tags
In
Tree
&
Browser: When enabled, auto-tags are displayed in the browser results (tag column), as well as in
the tag tree.
Hide
Unused
Auto-tags
In
Tree: When enabled, branches in the tag tree with zero associated files are hidden.
Highlight
UCS
Categories: When enabled, UCS-tagged content is highlighted in the browser, tag tree & assigner, and the UCS-
specific name shown.
Tree:
Limit
To
Custom
Tags: Click this to restrict the tag tree to custom tags
Tree:
Limit
To
UCS
Categories: Click this to restrict the tag tree to UCS tags/categories
Refresh
Auto-tags: Click to look for files that have not been auto-tagged
Reset
Tag
Filter: Click to remove all tags from the current filter criteria.

Tag
Column
(Search
Results)
In the Search
Results, look for the “Tags” column. It will show tags that have been assigned to each file (if the column isn’t visible,
right-click the header to bring up the column options).

Tags column, filtering results by the ‘Rustling’ tag

Click a tag to add it to the current filter
Click the “pencil symbol on the right side to bring up the Tag Assigner dialog

UCS
Categories
UCS stands for Universal
Category
System, and is an initiative started by a group of sound designers. UCS has a simple but powerful
idea at it’s core: establish a system of categories that is flexible enough to satisfy the needs of professional sound designers, and



ensure that these categories are available in any software.

At the most basic level, UCS is nothing more than a naming convention. And this is actually the genius of UCS: since the metadata is
simply part of the filename, you will be able to browse your samples using any software.

Starting with Sononym 1.6, UCS is “officially” supported, and UCS prefixes fully integrated into our tagging system. For example, any
file starting with “WEAPWhip_” will be auto-tagged with the “Sound Effects > Weapons > Weapon-Whip”.

It’s worth noting that UCS was primarily intended for sound-effects, and specifies only a few instrument categories. For this reason,
we decided to come up with a solution that ensures full support for UCS, while integrating it into an even larger system. In other
words, our tagging system is a superset of UCS.

You can read more about UCS here.

https://universalcategorysystem.com/


Classes
&
Categories
When a sound is added to a Sononym library, it will automatically be classified & categorized according to our machine-learning
model.

NB: This page explains how those categories and classes work. To learn how to sort and filter search results by category, please visit
the category filter page.

Classes
A sample can be classified in four different ways:

LOOP
ONESHOT
LOOP + ONESHOT (primarily a loop)
ONESHOT + LOOP (primarily a oneshot)

A sound is classified as a LOOP when it seems to have a looping or repetitive nature. Sononym does not (yet) assign categories to
Loops.
A sound is classified as a ONESHOT when the sound is non-repetitive. Oneshots are almost always categorized.

Categories
When processing a sample, the software will determine how much it matches the built-in categories. There are dozens of categories,
divided into three groups: Tonal, Percussive and Sound Effects (XFX).

Percussive
Sounds
This category covers sounds with a mostly ‘percussive’ quality. That is, mostly (or completely) atonal sounds with a clear impact,
leading into a sustained decay.

Bongos & Congas
Claps
Cymbal Crashes
Cymbal Rides
Hats & Shakers
Kicks
Metal Hits
Snares
Snips & Snaps
Toms
Vibraslap & Guiro
Vinyl Scratches
Wood Hits
Zaps & Blips

Tonal
Sounds
This category includes sounds with a primarily ’tonal’ character. The sounds can be both simple or complex, sustained or decaying.

Bass & LowKeys
Blips & HighKeys
Leads & MidHiKeys
Pads & Textures
Stabs & Orch. Hits
Triangles & Bells
Voice & Acapella

Sound
Effects
(XFX)
This category covers sound effects of various kinds.

Breaks & Smashes
Cracks & Rustle
Explosions & Shots
Nature & Athmospheric
Noise & Distortion
Sweeps & Lasers



Whooshes & Whips

Manually
override
classes
&
categories
While the classification system in Sononym can recognize sounds from a wide variety of sources, it certainly isn’t perfect. Therefore,
it’s possible to override predictions from the neural network. It’s dead simple - see the animation below:

‘Fixing’
a
sample
that
got
misclassified

When you override the value, your choice also affects how similarity search is working. A manually assigned class/category will
receive a “perfect” score, and as a result of this, will appear topmost in the search results when you browse by category.

Note that you can only use the pre-defined categories. We will introduce custom tagging at a later point, which will allow you to organize things
exactly as you want.



File
Formats
For reference, here are the available audio-formats for each platform:

Format,
file
extension Windows macOS
/
OS
X Linux

Advanced Audio Coding (.aac) Yes Yes

Audio Interchange (.aif, .aiff, .aifc) Yes Yes Yes

NeXT/Sun Audio (.au) Yes Yes

Core Audio Format (.caf) Yes

Free Lossless Audio Codec (.fla, .flac) Yes Yes Yes

OGG Vorbis (.ogg) Yes Yes Yes

MPEG-1 Audio Layer 2 (.mp2) Yes Yes Yes

MPEG-1 Audio Layer 3 (.mp3) Yes Yes Yes

MPEG-4 Part 14 (.mp4, .mp4a, .m4a) Yes Yes

Apple SouND (.snd) Yes Yes

Waveform Audio File (.wav) Yes Yes Yes

Windows Media Audio (.wma) Yes



Keyboard
shortcuts
Global
shortcuts
Global shortcuts are available at all times, no matter which part of the application that currently has focus.

Description Windows/Linux macOS

Playback: Play Selected File (restrict to selection, if present) Space Space

Playback: Play Similarity Src File Shift + Space Shift + Space

Playback: Play Random File Ctrl + Shift + Space Cmd + Shift + Space

Playback: Stop Preview / Recording Escape Escape

Playback: Toggle Recording Mode Ctrl + R Cmd + R

Playback: Toggle Loop Ctrl + R Cmd + R

Playback: Toggle Auto-Advance Ctrl + P Cmd + P

Playback: Punch-in Recording Ctrl + Shift + R Cmd + Shift + R

File: Open Folder Ctrl + O Cmd + O

File: Create Library Ctrl + N Cmd + N

File: Create Project Ctrl + Shift + Insert Cmd + Shift + Insert

File: Export Project Ctrl + E Cmd + E

Edit: Undo Query Change Alt + Left Arrow Alt + Left Arrow

Edit: Redo Query Change Alt + Right Arrow Alt + Right Arrow

Edit: Reset Query Alt + Del Alt + Del

Edit: Search Files Ctrl + F Cmd + F

Edit: Navigate Results Ctrl+K Cmd+K

Edit: Toggle Shuffle Mode Ctrl+Shift+S Cmd+Shift+S

View Locations Ctrl + Shift + L Cmd + Shift + L

View Projects Ctrl + Shift + C Cmd + Shift + C

View Favorites Ctrl+Shift+F Cmd+Shift+F

View Sidebar Ctrl + B Cmd + B

View: Zoom In Ctrl + Shift + + Cmd + Shift + +

View: Zoom Out Ctrl + Shift + - Cmd + Shift + -

View: Full Screen F11 ???

Open Preferences Ctrl+Comma Cmd+Comma

Local
shortcuts
Local shortcuts depend on the part of the user interface that currently has focus.

Description Applies
to Windows/Linux macOS

Add to Project Search results Ctrl+D Cmd+D



Add to Project (#Index) Search results Ctrl+[Numeric
Key 1-9]

Cmd++[Numeric
Key 1-9]

Add to New Project Search results Ctrl+Alt+D Cmd+Alt+D

Add to Favorites Search results Shift+F Shift+F

Remove from Favorites Search results Shift+C Shift+C

Find Duplicates List of Libraries, Folder Tree, Search results,
Project, Favorites

Alt+D Alt+D

Set as Hidden Search results Shift+D Shift+D

Unhide Selected Search results Shift+U Shift+U

Scroll to Previous Column Search Results Arrow Left Arrow Left

Scroll to Next Column Search Results Arrow Right Arrow Right

Exit Similarity Search Search results Shift+Escape Shift+Escape

Seek Back / Playback File Waveform panel, Search Results, Project,
Favorites

Arrow Left Arrow Left

Seek Forward / Playback File Waveform panel, Search Results, Project,
Favorites

Arrow Right Arrow Right

Preview File (From Beginning, or Selected
Range if Present)

Waveform panel, Search Results, Project,
Favorites

Return Return

Preview File (Force to Beginning of File) Waveform panel, Search Results, Project,
Favorites

Ctrl+Return Cmd+Return

Create New Folder Project Ctrl+Shift+N Cmd+Shift+N

Assign Color Project Shift+Insert Shift+Insert

Remove Color Project Shift+Delete Shift+Delete

Description Applies
to Windows/Linux macOS

Tip: Search Results also allow you to start typing in order to select a file. For example, entering “808” will take you to the first sample whose name
starts with those letters.

Shared
shortcuts
File
operations
Description Applies
to Windows/Linux macOS

Rename Clipboard F2 F2

Delete Clipboard Delete Delete

Reveal in Finder/Explorer Alt+Shift+R Alt+Shift+R

Clipboard
operations
Description Applies
to Windows/Linux macOS

Copy Clipboard Ctrl+C Cmd+C

Paste Clipboard Ctrl+P Cmd+P



List-based
widgets
Description Applies
to Windows/Linux macOS

Previous Entry All lists Arrow Up Arrow Up

Next Entry All lists Arrow Down Arrow Down

Previous Page All lists Page Up Page Up

Next Page All lists Page Down Page Down

First Entry All lists Home Home

Last Entry All lists End End

Expand Folder Tree widgets Right Arrow Right Arrow

Collapse Folder Tree widgets Left Arrow Left Arrow

Expand Selection Multi-select lists Shift+Up/Down Arrow Shift+Up/Down Arrow

Select All Multi-select lists Ctrl+A Cmd+A

Search
Input
Description Windows/Linux macOS

Previous Suggestion Arrow Up Arrow Up

Next Suggestion Arrow Down Arrow Down

Complete Suggestion Tab / Arrow Right Tab / Arrow Right

Sample
Playback
Of special consideration are the keyboard shortcuts for controlling sample playback.

Description Windows/Linux macOS

Global: Play Selected File
Playback Options determines if shortcut 'Starts', or 'Starts and Stops'.
If a selection is present in the audio, playback is restricted to the selection.

Space Space

Global: Play Similarity Src File
Will only work while a similarity search is active.

Shift+Space Shift+Space

Local: Play Selected File (Selection)
Not affected by Playback Options, will always behave like "Start Playing".
If a selection is present in the audio, playback is restricted to the selection.
The arrow keys double as shortcuts for seeking back & forward in the audio file. Thus, it's recommended
to use Return for retriggering samples.

Return
ArrowLeft
ArrowRight

Return
ArrowLeft
ArrowRight

Local: Play Selected File (Whole File)
Selection or not, the whole file is played from the beginning.

Ctrl+Return Cmd+Return



Preferences
The Preferences enables you to customize these application settings:

Audio
MIDI
Display
Search
Project

Audio
Configuration
Here you can specify the audio devices which are to be used by Sononym.

Note that you configure the Playback options from its own menu.

Audio Configuration (showing an error message)

General settings
Audio
System

The audio driver architecture that should be used.

A special entry is ‘Default’ (not listed), which will use the system’s default audio output device with a moderately high, but safe latency.

Architecture Windows Linux macOS

WASAPI Yes - -

Direct Sound Yes - -

WinMM - - -

Core Audio - - Yes

PulseAudio - Yes -

Alsa - Yes -



Jack - Yes -

Architecture Windows Linux macOS

Reload
Device
List
Reload the device list to detect newly connected sound-cards/drivers.

Device
The audio device that should be used for audio playback

Sample
Rate
The audio playback sample rate. The higher the sample rate, the more detailed the playback will be, but also the more CPU power will
be used.

Buffer
Size
The audio driver’s buffer size. Higher numbers will reduce the possibility of crackling sound at high CPU usage, but will also cause
more latency.

Play
Test
Sound
Starts a simple test sound to quickly check if the audio setup is working.

Reinitialize
Audio
System
Closes, then re-opens the connection to the soundcard/driver. May be useful for troubleshooting.

MIDI
Configuration
Here you can configure how (and if) you want to control sample playback using MIDI.

MIDI
Input
Device
Choose your MIDI Input Device

MIDI
Channel
Decide if you want to use a specific MIDI Channel on the input device.

Stop
playback
when
key
is
released
Enable this to stop sample playback when you release a note on the keyboard.

Ignore
incoming
MIDI
while
in
background
Enable this option to avoid that other software/hardware is triggering samples while not actively using Sononym.

Display
Configuration

Display - the dark theme has just been applied

Color Theme
Choose between a light and dark theme. The change is applied immediately.



Additional Options

Note that some options (zoom level & full-screen mode) are only available from the application menu.

Display
Specified a general size for table rows, tree widgets etc. Useful, e.g. to make the GUI more touch-screen friendly.

Font
type
Specify the font type - either use the built-in font, or the system default. The latter can be a better choice in case you have disabled
anti-aliasing on your computer.

Font
size
Specify which font-size to use.

Mouse
Wheel
/
Scrolling
Specify the desired scrolling behaviour and sensitivity:

		Touch/Trackpad:	Smooth	Scroll
		Mouse	Wheel:	One	notch	=	1	line
		Mouse	Wheel:	One	notch	=	2	lines	←	Default	choice
		Mouse	Wheel:	One	notch	=	3	lines
		Mouse	Wheel:	One	notch	=	4	lines

Note: the first option is recommended if you’re using a touch/trackpad and feel that scrolling is overly sensitive.

Search
Configuration
General Settings
Search
embedded
metadata
in
files
If enabled, all available metadata (such as artist name, genre and other information embedded into your files) is searched in addition to
the filename/path.

Preview
files
while
stepping
through
results
If enabled, files will be previewed while stepping through search results (i.e., while pressing and holding down the arrow up/down
keys). Requires that Auto-Play is enabled in the main toolbar.

Reset
filters
prior
to
launching
a
similarity
search
If enabled, all filters (including selected folder) are reset when launching a new Similarity Search.

Specify
which
network
port
to
use
Specify the port number we use for communicating with the audio analysis process (a.k.a. the Crawler). If this process is running, the
new value will be applied once the process has finished.

Project
Configuration
Default Settings
This section allows you to specify default settings. This includes where to store projects on disk, and whether they should make use
the auto-export feature.

NB: these settings applies to newly created projects. To change settings for an existing project, bring up its associated Options
dialog.

Other Settings
Post Export Action: What action to take after a successfull export has completed.
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